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Electronic Claims Using the ANSI 837 Format – User Guide  

 

NPI Numbers –Billing and Rendering NPI numbers must be correct on your claims. If incomplete or incorrect 
provider/NPI numbers are entered on your claims, the claim will be rejected by the Payer.  

Please verify with the insurance company if you are unsure of your NPI and/or Provider/Group numbers for a 
specific payer.  https://nppes.cms.hhs.gov/  

 

Program Updates 
Before you begin to enter patient data check for updates to your program. To check for updates go to 
‘Support/Help’ on the EZClaim menu bar and select ‘Check for Updates’.  

 

 
 

EZClaim Advanced 9 at a Glance 
 

https://nppes.cms.hhs.gov/
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ANSI 837 Quick Reference 
 

LOOP 2000A  (Specialty/Taxonomy) Segment EZClaim Location 

         Billing Provider Specialty Information PRV03 
Physician/Facility Library Icon>Billing or Rendering 
Provider >Taxonomy 

LOOP 2010AA  (Billing Provider)   

Billing Provider Name (Box 33) NM103 
Physician/Facility Library Icon>Billing Provider Name 
and Address 

Billing Provider Primary Identifier NM109 Physician/Facility Library Icon>Billing Provider>NPI 

Billing Provider Secondary Identifier REF02 
Physician/Facility Library Icon>Billing Provider >Tax 
ID# 

Billing Provider Secondary Identifier REF02 
Physician/Facility Library Icon>Billing Provider 
>Legacy ID# 

Billing Provider Address N3 & N4 
Physician/Facility Library Icon>Billing 
Provider>Address & 9 digit Zip Code 

LOOP 2310B  (Rendering)   

Rendering Provider Name (Box 31) NM103 
Physician/Facility Library Icon>Rendering Provider 
First and Last Name 

Rendering Provider Primary Identifier NM109 
Physician/Facility Library Icon>Rendering 
Provider>NPI 

LOOP 2310A  (Referring)   

Referring Provider Name (Box 17) NM103 
Physician/Facility Library Icon>Referring Provider 
First and Last Name 

Referring Provider Primary Identifier NM109 
Physician/Facility Library Icon>Referring 
Provider>NPI 

LOOP 2310C (Facility)   

Service Facility Name (Box 32) NM103 Physician/Facility Library Icon> Facility Name 

Facility Address N3 & N4 
Physician/Facility Library Icon>Facility>Address & 9 
digit Zip Code 

Facility Primary ID# (If required) NM109 Physician/Facility Library Icon>Facility NPI 

LOOP 2010BB  (Payer)   

Payer (Insurance Co.) Name NM103 Payer Library Icon>Payer Name 

Payer ID# NM109 Payer Library Icon>Payer ID 

LOOP 2300     

Claim Information  
General claim information plus Diagnostic Codes and 
Total Claim Charge 

LOOP 2400   

Service Line Information (Charges tab)  
Data related to procedure code charges. Ex: Dates, 
procedure codes, modifiers, etc. 
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ANSI 837 Electronic Claims Data Entry 

 Note: Entering the following data will result in ANSI 837 errors! 

 Do not use words such as “Same” “None” or “N/A”. Use only valid data in fields.  

 Do not use MR., MS. or other prefixes. Do not use DR. MD, OD etc. A provider is identified by their NPI or 
Provider number. 

 Unless required by your payers do not use any special characters such as hyphens, commas, 
apostrophes, etc. 

Step 1 - Submitter/Receiver Information 
ToolsOptionsSubmitter Information 

 
Note: Contact your payer for Submitter/Receiver information including the Payer ID number. 

1. Click on ‘Submitter Information’ tab.  
2. Do not enter ‘Pay to Provider’ unless using a Post Office box number for billing address. See Step 3 for 

setting up PO Box information.  
3. Click on Submitter/Receiver Library button. 

 

 
 

 

4. To ‘Add’ a new Library entry, click on ‘New’, enter all required data and then click on ‘Save’. Go to Payer 
Info (see above) for the following Payer specific information. 
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Required Fields 

 Library Entry Name - Enter a name to identify the library entry. 

 Export Format - Choose the export format from the drop down list.   

 Submitter Type - Use the drop down box to choose a Person or Non-Person type. 

 Submitter Name - Enter the name of the person or company submitting the file. 

 Submitter Identifier – Enter the EDI submitter number provided by the insurance carrier that identifies the 
submitter of the file. Contact your insurance carrier for your EDI submitter ID#. 

 Contact - Enter the name of the contact person.  

 Telephone Number - Enter the phone number of the contact person in this format, 5556667777. 
 

Note: Contact your payer for Submitter/Receiver information including the Payer ID number 

 Receiver Name - Information is provided by your insurance carrier. 

 Interchange Receiver ID (ISA08)- Information is provided by your insurance carrier. 

 Receiver ID (NM109) - Information is provided by your insurance carrier.  

 Test/Production Indicator - Enter either TEST or PROD. 

 Receiver Code (GS03) - Information is provided by your insurance carrier. 

Situational Fields 

NOTE: Do not enter Situational fields unless required by insurance carrier or errors will be generated! 

 ‘Strip extra characters from ID fields’ - Usually checked, uncheck only if the insurance company 
requires a dash in your Tax ID# for electronic claims. 

 Sender ID – Enter only if a different number than the Submitter ID number. 

 Sender Code – Enter only if different number than the Submitter ID number. 

 Password – Do not enter unless required by your insurance company for electronic claims. 

 Acknowledgment Requested - Usually left checked. 

 Zip Export File – Usually left unchecked unless requested by your insurance company. 

Step 2 - Payer Library 
 Payer Library Icon 

 
Note: This information must be entered before entering ‘Physician Library’ data. 

 

Add Payer Information to Library 

1. Enter name of Insurance carrier. 
2. Enter Payer ID# in ‘Payer ID’ field.  Contact your Payer for Payer ID#. 
3. Address is only required for paper claims.  
4. Ins Type Code: Select only if sending Medicare claims as a secondary payer.  Use dropdown arrow to 

select ‘Medicare Secondary Claims’ Ins Type code. 

5. Click on the’ Save’ button. 
6. Payer information is now listed in the box to the left.  

Edit Payer Information 

Highlight the Payer, edit Payer information and then click on the ‘Save’ button. 
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Step 3- Physician, Organization and Facility Library 
Physician Library Icon 

 

Physician/Facility Library – Library information must be completed before entering patient data.  

Once the entries are completed in the library, they will be selected on EZClaim data entry screens.  Correct 
set-up of the Library is important for error free claims. 

Billing Provider Information (Box 33 on CMS 1500 form) 

Note: Do not use initials or credentials. MR., MS., DR., MD, INC. etc. 
 

 
 
1. Enter the Name of Provider, Agency or Business in “Full Name Required’ field. 

2. Select ‘Billing’ as Classification. 

3. Select Person or Non-Person as ‘Type’ depending on the billing provider entry. 

4. Enter ‘Organization’ name or ‘Last Name’ and ‘First Name’ if person.  

5. Enter street Address information including 9 digit Zip Code. 

 Note: A P.O. Box address requires setting up a separate billing entry using the Classification of 

‘Pay to Provider’. Once the entry is completed, go to Tool>Options>Submitter Information to 

select your ‘Pay to Provider’ entry. 

 
6. Enter Individual or Organizational NPI number.  

7. Using the dropdown arrow, select ‘Tax ID Type’ and enter number.  

8. Enter Taxonomy Code if required by your insurance company. 
Note: Fax and Email is used for your reference only. 

Additional ID numbers 

1. Situational: Select’ Payer’ by clicking in the blank line under ‘Payer’. Continue entering ID Type and either 
the Individual or Group ID Number. 
 

 

Use dropdown arrow to select 
Classification type 

9 digit Zip Code 
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2. Click on ‘Save’. 

Rendering Provider Information  

If the Billing provider has obtained an Organizational NPI, the provider may also need a Rendering Provider entry 
for their Individual NPI/ Provider number. 

1. Enter First and Last name in ‘Full Name (Required)’ field. 

 
 
2. Select ‘Rendering’ as ‘Classification. 
3. Select Person as Type. 
4. Enter Last name and First name.  
5. Enter Individual NPI number.  

Optional: If a Tax ID is required, enter under ‘Additional ID Numbers’.  
6. Click on ‘Save’. 

Facility Information 

Enter Facility information only if different than the Billing Provider information. (Box 33 of the 1500 form.) 
 
1.    Enter Facility Name in ‘Full Name (Required)’ field. 
2.    Select ‘Facility’ as ‘Classification’. 
3.    Select Non-Person as ‘Type’. 
4.    Enter Facility Name and Address information including 9 digit Zip Code. 
5.    Enter NPI number. 
6.    Click on ‘Save’. 

Referring Provider Information 

1. Enter First and Last name in ‘Full Name (Required)’ field. 
2. Select ‘Referring’ as ‘Classification’. 
3. Select Person as ‘Type’. 
4. Enter Last name and First name. 
5. Enter NPI number. 
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Step 4 - Patient/Insured Info Screen 
 Do not use initials or credentials. MR., MS., DR., MD, INC. etc. 

 Do not use words such as ‘SAME’ or ‘NONE’ or ‘N/A’. 
 

 

Required: Patient name and address information   
Required: Insured information is required if ‘Insured’ is different than the ‘Patient’. 
Required: Enter Insured ID Number in this format, 2345678. Do not use dashes or punctuation. 
Required: Patient’s Birth Date 
Required: Patient Relationship to Insured 
Required: Patient Signature on File 
Required: Check ‘Insured Signature on File’ for payment to be sent to Provider. If not checked, payment will be 
sent to the Insured. 
Box 9b-9c – Reserved for NUCC use.  Not used for electronic billing 
 
Other Insured Information. 

 Enter secondary data only if submitting a secondary insurance for this claim.  

 Enter secondary ‘Insured’s ID’ and ‘Patient Relationship to Insured’ on the Payers/Other Info tab. 
 
Note: Enter additional information if requested by the insurance company. 

Step 5 - Physician/Diagnostic Info Screen  
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Field Requirements 
Required: Billing Provider Info & Phone Number information.  Use dropdown arrow to select the 

Physician/Organization name previously set up in the Physician/Facility Library page * 

Required: Accept Assignment indicator. ‘Yes’ or ‘No’ 

Required: Physician Signature on File indicator 

 

If required by your Payer, enter the following information.  

 Rendering Provider information previously set up in the Physician/Facility Library. 

 Date of Current: This is the default ‘Date of Current’ field. Enter a date in this field only if the date is 

used for all charges for this patient. For Medicare this date cannot be same as first date of service. 

 Referring or Ordering Provider  

Facility Information: Do not enter facility information unless Facility data is different from Billing information or 
Place of Service is a 12 or required by your insurance company 

Step 6 - Payers and Others Info Screen 
 

 

Primary/Destination Payer 

1. Required: Click ‘Primary Payer’ button to select Payer previously set up in the Payer Library. Select 

‘Payer’ by highlighting the Primary Payer and click ‘OK’. 

2. Required: ‘Primary Claim Filing Indicator’.  

Secondary/Other Payer 

1. Required: Secondary/Other Payer 

2. Required: Claim Filing Indicator  

3. Required: Secondary/Other Insured’s ID# 

4. Required: Patient Relationship to Insured 

EDI Claim Notes: To include notes in Loop 2300 NTE Segment of your electronic file, check the ‘Include 
Notes with EDI’ file checkbox. 
 

Note: See tabs below for additional Situational information. Do not enter ‘Situational’ information unless 

required by your insurance company. 

Note: To Delete a Payer on Payer/Others Info screen, click on the ‘Clear Primary’ or ‘Clear Secondary’ button. 
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Step 7 - New Charges Screen 
 

 
 
Required: Click on the calendar to select ‘Date of Service’.  Enter charges and other service line information.  
Required: ICD Indicator, using the dropdown box select 9 for ICD-9 or 0 for ICD-10 codes.  Cannot have 
BOTH ICD-9 AND ICD-10 codes on a claim. 
 

 
 
Required: Diagnosis codes.  
Required: Enter the diagnostic code pointers (ABCD etc.) on the charges line. Do not use the actual diagnosis 
code in this box, 24E, only pointers. Enter no more than four DX pointers on each service line.  
Required: Procedure Codes  
Required: Place of Service, must use 2 digits.  

The most commonly used codes. For additional codes visit www.wpc-edi.com/reference. 
11 - Office 
12 – Home 
21 - Inpatient Hospital 
22 - Outpatient Hospital 
24 - Ambulatory Surgical Center 
41 – Ambulance (Land) 
99 – Other Unlisted Facility 

 
Situational: Rendering Provider: This data is pulled from the Rendering Provider information which has been 
selected on the Physician/Diagnostic Info tab.  If Rendering Provider information has not been selected on the 
Physician/ Diagnostic Info tab, use the dropdown arrow to select the Rendering Provider previously set up in 
the Physician/Facility Library. 
 
Situational: Enter EMG only if requested by your insurance company. Usually left blank. 

Note: DME Companies do not use Rendering Providers.  Leave the rendering provider fields blank 

DME, Ambulance and Chiropractic ANSI 837 Screens 

DME, Ambulance and Chiropractic screens require an extended features registration number. Contact 
EZClaim if you require one of these screens. 

 Ambulance 

 Chiropractic 

 DME/CMNs 
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Ambulance Screen 

Ambulance Trip Information 
To enter information about an ambulance trip, open the ambulance information screen. 
Click on the Ambulance button. 

 

Enter Ambulance codes into dialog box. 

 

Transport Reason Codes: 
A Patient was transported to nearest facility for care of symptoms, complaints, or both. 
B Patient was transported for the benefit of a preferred physician. 
C Patient was transported for the nearness of family members. 
D Patient was transported for the care of a specialist. 
E Patient transferred to rehabilitation facility. 

Miles 
Enter number of Miles traveled, use decimal points if needed  ie. 10.5 

Condition Indicators: 

01 Patient was admitted to a hospital 
04 Patient was moved by stretcher 
05 Patient was unconscious or in shock 
06 Patient was transported in an emergency situation 
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07 Patient had to be physically restrained 
08 Patient had visible hemorrhaging 
09 Ambulance service was medically necessary 
12 Patient was confined to a bed or chair 

Round Trip Purpose Description 
A free form description to clarify the purpose for the round trip ambulance service. 

Stretcher Purpose Description 
A free form description to clarify the purpose for the usage of a stretcher during ambulance service. 

Pickup Location and Drop Off Location 
 Enter the addresses of the Pickup and Drop Off Locations 

Chiropractic Screen 
Click on the Chiropractic button. 
 

 

Enter codes necessary to supply information related to the chiropractic service rendered to a patient. 

ANSI 5010 requires only ‘Nature of Condition’ & ‘Acute Manifestation Date’. 

 

Click the ‘Copy Previous Values’ button to copy the values from the previous claim for this patient. 

Acute Manifestation Date 
This date is exported into the DTP*453 segment in loop 2300 of the ANSI 837 file. 

Nature of Condition – CR2 08 
Code indication the nature of a patient’s condition. 

A Acute Condition 
C Chronic Condition 
D Non-acute 
E Non-Life Threatening 
F Routine 
G Symptomatic 
M Acute Manifestation of a Chronic Condition 

Patient Condition Description 1 & 2 – CR2 11/11 
This is a free form description to clarify the related data elements and their content.  Limit to 80 characters per 
field. 
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DME/CMN Screen 

When sending claims to one of the 4 DMERC regions, it may be necessary to attach electronic CMNs to 
service/product line items.  EZClaim allows a user to attach a CMN to the ‘claim’ and the CMN will be attached 
ONLY to line items that have a check in the CMN box. 

 

When entering a new claim, EZClaim will remind you to attach a CMN if the CMN box is checked but no CMN 
has been attached. 

Copying Previous CMNs 
If you check the CMN box on a service line and a CMN is not currently ‘attached’ to this claim, EZClaim will 
prompt to copy the previous CMN to this claim.  This prevents having to enter the CMN information again. 

Attaching a CMN to a Claim 
Click on the ‘Attach CMN’ screen. 

 

 
 

1. Select by highlighting the CMN for this claim and click the OK button.  
 

 
 

2. Enter Data into the CMN screen.  The CMN screens represent Section B of the CMN.   
3. Please note the Length of Need, Initial Date, and Signed Date are all required fields.  EZClaim will not let 

you close the CMNscreen until those fields are entered. 
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Printing CMNs 

How do I print CMNs? 

 Once service lines have been entered onto a claim, you can print a CMN.  Click the ‘Attach CMN 
Form’ or the button labeled with the CMN name (i.e. ‘Hospital Beds CMN’).  There will be a ‘Print’ 
button available to print the CMN.  The CMN printed will contain both sides of the CMN form. 

 Section A – Patient Name – Data is pulled from the Patient information on the left hand side of the 
Patient/Insured Info screen (Box 1a, 2, and 5 on the CMS-1500). 

 Section A – Supplier Name – Data is pulled from the Physician/Supplier information on the bottom 
right of the Physician/Diagnostic Info screen (Box 33 on the CMS-1500). 

 Section A – Place of Service – Data is pulled from the first service line’s place of service value. 

 Section A – HCPCS Codes – Data is pulled from the CPT/HCPCS column on the charges screen.  
IMPORTANT: Only HCPCS codes from service lines that have the ‘CMN’ box checked will print in this 
area. 

 Section A – Patient DOB, etc – Patient DOB, and Sex is pulled from the patient info on the 
Patient/Insured Info screen.  Height and Weight is pulled from the Payers/Other Info screen>Misc 
Patient Data tab. 

 Section A – Physician Name and UPIN – Data is pulled from the Referring/Ordering drop down box on 
the Physician/Diagnostic Info screen, the UPIN from the ‘ID of Referring Physician’ field.  The address 
and phone number are pulled from the physician’s entry in the Physician Library. 

 Note: – Narrative – Other information may be printed depending on CMN selected and information 
required. Up to 10 service lines of information can be printed.  The CPT/HCPCS and Units information 
is pulled from the service lines.  The Description, Charges, and Allowed Amounts are pulled from the 
Procedure Code Library. 
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Exporting Claims 
Electronic Claims Icon the Menu bar 

 

Once the patient and claim data has been entered into the EZClaim program you are now ready to generate 
your file for electronic transmission.  

Submitter/Receiver Data Entry 
1. Go to ‘Electronic Claims’ 
2. Using the dropdown select the file ‘Format' being submitted. Ex: For all ANSI files the ANSI 837 would be 

selected.  
3. Select the correct Submitter/Receiver information for the file being submitted. 

Note: Clicking on the  button to the right will open the full Submitter/Receiver Library. 
 

 

Exporting Claims 

1. Select claims to be exported by checking the check box next to claim.  Note: You may also click the 
‘Check All’ box if all claims are ready to submit. 

2. Once claims have been selected, click on the ‘Check for Errors’ button to analyze the file before submitting 
to the insurance carrier. If errors are found, return to patient record and update data.  
 

 
 

3. To view the full analyzed file click the Detailed View button.   
4. Return to ‘Electronic Claims’ dialog box and click on the ’Export’ (Create Batch and Send) button.  
5. In the ‘Save As’ dialog box, click the ‘Save In’ dropdown arrow and select ‘Desktop’ or a location of your 

choice. 
6. By default, file name will be ‘Claimdat’. The file name ‘Claimdat’ should be changed for each submission. 

Some providers use a Filename based on the date of submission. EX: 010112.txt.  
IMPORTANT: If your payer uses a specific file location and file name, follow the payer’s instructions. 
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7. Click on the ‘Save’ button. Please note the full Path and Filename of your batch file. 
 

 
 

8. If you would like a printed Submission report, click ‘Yes’ to print report. (Submission Reports are saved 
and may be accessed by going to File on the menu bar>Reports>Submission Reports.) 

9. In the ‘Send Exported Claims’ dialog box, enter transmission telephone number or Web page address if 
submitting over the Web and click ‘Go’. 
 

 
 

10. If you entered a telephone number, once connected follow payer’s instructions for entering Logon ID and 
Password. (Below is a sample ‘Bulletin Board’ system. Your Payer may use a different system.) 
 

 
 

11. When asked to ‘Send’ file, click on ‘Send File’ on the menu bar of the Terminal program. 
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12. Using dropdown arrow select Modem protocol for transmission.  We suggest using ZModem protocol for 
uploading files. (Check your Payer’s Bulletin Board instructions for modem requirements.) 
 

 
 

13. In ‘Send File’ dialog box enter ‘Filename’ by right clicking in the box and selecting ‘Paste’, or click on  to 
browse and select your file. 

14. Click ‘Send’. 
15. Follow payer’s remaining instructions. 

Re-Exporting Claim Data 
Selecting Previously Submitted Claims 

1. Click on ‘Show Previous Batch’ button. 

 
 

2. Double click on the previous batch of claims to view. 

 
 

3. Select by clicking the check box(s) or use the ‘Check All’ button. 
4. Click on the ‘Export (Create Batch)’ or ‘Export (Create Batch and Send)’ button. 
5. Re-export claims. 

Terminal - Retrieving Reports 
Menu Location: File > Terminal Program 

 
Note:  If your insurance company (Payer) uses a Bulletin Board system, follow these instructions.  For all 
other submission methods follow the instructions for that Payer. 
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Use EZTerminal to dial into the Payer’s computer. Once connected you can access all the features of the 
Payer’s Bulletin Board System. (BBS) 

Using the EZTerminal Send File Feature 
 
1. Go to File on the menu bar, select ‘Terminal Program’. 
2. Confirm the correct phone number and modem by clicking on ‘Setup’. 
3. Click on ‘Connect’. 
4. Once connected use features of Payer’s BBS to navigate screens. 
5. When sending file, click ‘Send File’ on menu bar and enter the Filename by right clicking and choosing 

‘Paste’. Select Protocol. Use ZModem or choose alternate protocol by clicking on dropdown arrow. 
6. When finished click the ‘Hang Up’ button 

Using the EZTerminal Receive File Feature 
 

The following are general instructions for retrieving response files. Your Bulletin Board System (BBS) may 
have different requirements. 

Tip: When viewing the list of files to download on the BBS, use EZTerminal’s ‘Print Screen’ menu item to print 
the page of filenames.  This helps if searching for the downloaded file. 

1. Log into BBS using the carrier’s BBS instructions 
2. Navigate to the download section. 
3. At some point you may be asked to select a protocol.  We suggest using ZModem  

 

 
 

4. Select the file to download. (If there are additional files, you may have to repeat process) 
5. Click the ‘Receive File’ item on the EZTerminal menu bar.  A receive box will appear. 
6. Use the ‘Browse’ button to choose the location for saving the file, we suggest saving files to the Desktop 

for easy retrieval. 
7. Select ZModem  
8. Click on the 'Receive File' button. 
9. When asked if you would like to Analyze file select ‘YES’.  NOTE: If you are using Hyper Terminal or 

Web based submission you must use the EZClaim File Analyzer to analyze your reports.   
10. Print error report. 
11. If windows opens a box asking which program to use when opening the file, scroll down and choose 

'WordPad' or ‘Notepad’ 
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Analyzing Downloaded EDI Reports with the EDI File Analyzer 

Tools > EDI File Analyzer 
 

 

1. Click on Browse and select the file. 

  
 

2. Click the Analyze button. 

 
 

3. The results will appear in WordPad or Notepad. 

Analyzing Reports when using EZTerminal 

When files are downloaded with the Terminal Program built into EZClaim, the program will ask if you want to 
analyze the file.  Select ‘Yes’.   

Compatible Formats 

 ANSI 277CA – Claim Acknowledgement Report 

 ANSI 278 – Authorization File 

 ANSI 835 – Electronic Remittance Advice 

 ANSI 837 – Electronic Claim File 

 ANSI 864 – Status file returned by DMERC Region B 

 ANSI 997 – Functional Acknowledgement 

 ANSI 999 – Functional Acknowledgement 

 Availity EBR Raw Data File 

 United HealthCare Medicare Part B and DMEPOS Electronic Claim Reject Report 
 


